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Overview 

*sniff* *sniff* ... do you smell that? No need to stick your nose into a carton of milk

anymore, you can build a digital nose with the SGP40 Multi-Pixel Gas Sensor, (https://

adafru.it/PBE) a fully integrated MOX gas sensor. This is a very fine air quality sensor

from the sensor experts at Sensirion, with I2C interfacing so you don't have to

manage the heater and analog reading of a MOX sensor. It combines multiple metal-

oxide sensing and heating elements on one chip to provide more detailed air quality

signals.
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The SGP40 has a 'standard' hot-plate MOX sensor, as well as a small microcontroller

that controls power to the plate, reads the analog voltage and provides an I2C

interface to read from. Unlike the CCS811, this sensor does not require I2C clock

stretching. We currently have an Arduino library with examples of reading the raw

value and also running the Sensirion algorithm to calculate VOC index (https://

adafru.it/PaX) but the Python library currently only has raw readings. Python support

for VOC index requires a port of the Sensirion C library.

This is a gas sensor that can detect a wide range of Volatile Organic Compounds

(VOCs) and H2 and is intended for indoor air quality monitoring. The SGP40 is the

next generation after the SGP30, but does not give TVOC/eCO2 values out like the

SGP30. Instead, raw signal from the sensor is processed using their software

algorithm to give an overall 'air quality' value form 0 to 500 (https://adafru.it/PaY).

Please note, this sensor, like all VOC/gas sensors, has variability, and to get precise

measurements you will want to calibrate it against known sources! That said, for

general environmental sensors, it will give you a good idea of trends and comparison.

Another nice element to this sensor is the ability to set humidity compensation for

better accuracy. An external humidity sensor is required and then the RH% is written

over I2C to the sensor (https://adafru.it/PaZ), so it can better calibrate the MOX sensor

reading and reduce humidity/temperature-based variations..
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Nice sensor right? So we made it easy for you to get right into your next project. The

surface-mount sensor is soldered onto a custom made PCB in the STEMMA QT form

factor (https://adafru.it/LBQ), making them easy to interface with. The STEMMA QT

connectors (https://adafru.it/JqB) on either side are compatible with the SparkFun

Qwiic (https://adafru.it/Fpw) I2C connectors. This allows you to make solderless

connections between your development board and the SGP40 or to chain it with a

wide range of other sensors and accessories using a compatible cable (https://

adafru.it/JnB). QT Cable is not included, but we have a variety in the shop (https://

adafru.it/JnB)

We’ve of course broken out all the pins to standard headers and added a 3.3V

voltage regulator and level shifting so allow you to use it with either 3.3V or 5V

systems such as the Arduino Uno, or Feather M4, or Raspberry Pi.
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Pinouts 

Power Pins:

Vin - this is the power pin. Since the sensor chip uses 3 VDC for logic, we have

included a voltage regulator on board that will take 3-5VDC and safely convert it

down. To power the board, give it the same power as the logic level of your

microcontroller - e.g. for a 5V micro like Arduino, use 5V

3.3V - this is the 3.3V output from the voltage regulator, you can grab up to

100mA from this if you like

GND - common ground for power and logic

Data Pins

SCL - I2C clock pin, connect to your microcontrollers I2C clock line. Can use 3V

or 5V logic, and has a 10K pullup to Vin 

SDA - I2C data pin, connect to your microcontrollers I2C data line. Can use 3V or

5V logic, and has a 10K pullup to Vin

STEMMA QT (https://adafru.it/Ft4) - These connectors allow you to connectors to

dev boards with STEMMA QT connectors or to other things with various

associated accessories (https://adafru.it/Ft6) 

 

• 

• 

• 

• 

• 

• 
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Arduino 

Using the SGP40 with Arduino is a simple matter of wiring up the sensor to your

Arduino-compatible microcontroller, installing the Adafruit SGP40 (https://adafru.it/

PaX) library we've written, and running the provided example code.

I2C Wiring 

Use this wiring if you want to connect via I2C interface. The default I2C address for

the SGP40 is 0x59. 

Here is how to wire up the sensor using one of the STEMMA QT (https://adafru.it/Ft4)

connectors. The examples show a Metro but wiring will work the same for an Arduino

or other compatible board.

 

Connect board VIN (red wire) 

to Arduino 5V if you are running a 

5V Arduino (Uno, etc.). If your

Arduino is 3V, connect to that

instead.

Connect board GND (black

wire) to Arduino GND

Connect board SCL (yellow

wire) to Arduino SCL

Connect board SDA (blue

wire) to Arduino SDA

Here is how to wire the sensor to a board using a solderless breadboard:

 

Connect board VIN (red wire) 

to Arduino 5V if you are running a 

5V Arduino (Uno, etc.). If your

Arduino is 3V, connect to that

instead.

Connect board GND (black

wire) to Arduino GND

Connect board SCL (yellow

wire) to Arduino SCL

Connect board SDA (blue

wire) to Arduino SDA

• 

• 

• 

• 

• 

• 

• 

• 
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Library Installation 

You can install the Adafruit SGP40 library for Arduino using the Library Manager in the

Arduino IDE.

Click the Manage Libraries ... menu item, search for Adafruit SGP40 , and select the A

dafruit SGP40 library:

Follow the same process for the Adafruit BusIO library.

Finally follow the same process for the Adafruit SHT31 Library:

Load Basic Example 

Open up File -> Examples -> Adafruit SGP40 -> sgp40test
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After opening the demo file, upload to your Arduino wired up to the sensor. Once you

upload the code, you will see the Raw measurement values being printed when you

open the Serial Monitor (Tools->Serial Monitor) at 115200 baud, similar to this:

These measurements rare the raw values from the VOC-sensitive resistor. They aren't

quite 'resistance' but they're related. The number is affected by VOC as well as

humidity.

VOC Index Example Code 

Next we'll use the SGP40 along with a SHT31 humidity sensor to calculate the VOC

Index, with the SHT31 providing humidity measurements to allow the SGP40 to correct

for it

For this example, you'll need to add a SHT31 (https://adafru.it/y7f) humidity sensor to

the I2C bus, connected along with the SGP40 to the Metro/Arduino. 
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Simply add connections for VIN, GND, SCL, and SDA between the SGP40 and SHT31

as seen above. Alternately the SHT31 can be wired directly to the Metro's I2C

connections.

With the wiring done, open up File -> Examples -> Adafruit SGP40 -> sgp40_voc

After opening the demo file, upload to your Arduino wired up to the sensor. Once you

upload the code, you will see the raw measurement and VOC Index values being

printed when you open the Serial Monitor (Tools->Serial Monitor) at 115200 baud,

similar to this:

It may take several minutes for the Voc index to start changing as it calibrates the

baseline readings. We use the Sensirion SGP40 algorithm found here (https://

adafru.it/PaY)

Arduino Docs 

Arduino Docs (https://adafru.it/Pbp) 

Python & CircuitPython 

It's easy to use the SGP40 with Python or CircuitPython, and the Adafruit

CircuitPython SGP40 (https://adafru.it/PBZ) module. This module allows you to easily

write Python code that reads gas measurements from the SGP40 sensor.
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You can use this sensor with any CircuitPython microcontroller board or with a

computer that has GPIO and Python thanks to Adafruit_Blinka, our CircuitPython-for-

Python compatibility library (https://adafru.it/BSN).

CircuitPython Microcontroller Wiring 

First wire up a SGP40 to your board exactly as shown below. Here's an example of

wiring a Feather M4 to the sensor with I2C using one of the handy STEMMA QT (http

s://adafru.it/Ft4) connectors:

 

Board 3V to sensor VIN (red wire)

Board GND to sensor GND (black

wire)

Board SCL to sensor SCL (yellow

wire)

Board SDA to sensor SDA (blue

wire)

You can also use the standard 0.100" pitch headers to wire it up on a breadboard:

 

Board 3V to sensor VIN (red wire)

Board GND to sensor GND (black

wire)

Board SCL to sensor SCL (yellow

wire)

Board SDA to sensor SDA (blue

wire)

Python Computer Wiring 

Since there's dozens of Linux computers/boards you can use, we will show wiring for

Raspberry Pi. For other platforms, please visit the guide for CircuitPython on Linux to

see whether your platform is supported (https://adafru.it/BSN). 

• 

• 

• 

• 

• 

• 

• 

• 
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Here's the Raspberry Pi wired to the sensor using I2C and a STEMMA QT (https://

adafru.it/Ft4) connector:

 

Pi 3V to sensor VCC (red wire)

Pi GND to sensor GND (black wire)

Pi SCL to sensor SCL (yellow wire)

Pi SDA to sensor SDA (blue wire)

Finally here is an example of how to wire up a Raspberry Pi to the sensor using a

solderless breadboard

 

Pi 3V to sensor VCC (red wire)

Pi GND to sensor GND (black wire)

Pi SCL to sensor SCL (yellow wire)

Pi SDA to sensor SDA (blue wire)

CircuitPython Installation of SGP40 Library 

You'll need to install the Adafruit CircuitPython SGP40 (https://adafru.it/PBZ) library on

your CircuitPython board.

First make sure you are running the latest version of Adafruit CircuitPython (https://

adafru.it/Amd) for your board.

Next you'll need to install the necessary libraries to use the hardware--carefully follow

the steps to find and install these libraries from Adafruit's CircuitPython library bundle 

(https://adafru.it/ENC).  Our CircuitPython starter guide has a great page on how to

install the library bundle (https://adafru.it/ABU).

• 

• 

• 

• 

• 

• 

• 

• 

©Adafruit Industries Page 12 of 16



Before continuing make sure your board's lib folder or root filesystem has the adafrui

t_SGP40.mpy file and adafruit_bus_device folder copied over. Your CIRCUITPY drive

should look like this:

Next connect to the board's serial REPL  (https://adafru.it/Awz)so you are at the

CircuitPython >>> prompt.

Python Installation of SGP40 Library 

You'll need to install the Adafruit_Blinka library that provides the CircuitPython

support in Python. This may also require enabling I2C on your platform and verifying

you are running Python 3. Since each platform is a little different, and Linux changes

often, please visit the CircuitPython on Linux guide to get your computer ready (https

://adafru.it/BSN)!

Once that's done, from your command line run the following command:

sudo pip3 install adafruit-circuitpython-sgp40

If your default Python is version 3 you may need to run 'pip' instead. Just make sure

you aren't trying to use CircuitPython on Python 2.x, it isn't supported!

CircuitPython & Python Usage 

To demonstrate the usage of the sensor we'll initialize it and read the raw gas

measurements from the board's Python REPL.

Run the following code to import the necessary modules and initialize the I2C

connection with the sensor:

 

• 
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import board
import busio
import adafruit_sgp40

i2c = busio.I2C(board.SCL, board.SDA)
sgp = adafruit_sgp40.SGP40(i2c)

Now you're ready to read values from the sensor using the raw property to read the

raw gas measurements.

print("Raw Gas: ", sgp.raw)

These measurements rare the raw values from the VOC-sensitive resistor. They aren't

quite 'resistance' but they're related. The number is affected by VOC as well as

humidity.

Example Code 

# SPDX-FileCopyrightText: 2020 by Bryan Siepert for Adafruit Industries
#
# SPDX-License-Identifier: Unlicense
import time
import board
import adafruit_sgp40

# If you have a temperature sensor, like the bme280, import that here as well
# import adafruit_bme280

i2c = board.I2C()  # uses board.SCL and board.SDA
sgp = adafruit_sgp40.SGP40(i2c)
# And if you have a temp/humidity sensor, define the sensor here as well
# bme280 = adafruit_bme280.Adafruit_BME280_I2C(i2c)

while True:
    print("Raw Gas: ", sgp.raw)
    # Lets quickly grab the humidity and temperature
    # temperature = bme280.temperature
    # humidity = bme280.relative_humidity
    # compensated_raw_gas = sgp.measure_raw(temperature = temperature, 
relative_humidity = humidity)
    print("")
    time.sleep(1)
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Python Docs 

Python Docs (https://adafru.it/PBD) 

Downloads 

Files:

SGP40 Datasheet (https://adafru.it/Pbi) 

Fritzing object in the Adafruit Fritzing Library (https://adafru.it/Pbj) 

EagleCAD PCB files on GitHub (https://adafru.it/Pbk) 

Schematic

• 

• 

• 
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Fab Print
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